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By David Harris, President

“Practice Safe Hex”
This is a comprehensive computing term meaning be
careful on the Internet, especially with e-mail and while
browsing. This includes never responding in any way
(including “remove me” requests) to mail from spammers,
and instantly deleting any spam e-mail.
This also includes never opening any e-mail
of suspicious origin, or with suspicious attachments.
This especially means be very suspicious
of e-mail attachments from acquaintances,
as new viruses spread rapidly, often infecting computers faster than the antivirus pubHARRIS
lishers can post updates.
Other forms of “safe hex” include killing spyware
(Spybot
Search
and
Destroy,
free
at
www.safer&#8209;netwot*jng.org, and using a firewall to
keep intruders out of your computer. Outpost
(www.agnitum.com) and ZoneAlarm (www.zonelabs.com)
are available free for personal use.
There is absolutely no reason not to have current antivirus
software installed. Price can not be an issue, because there
are still several freeware titles available from AVG at
www.grisoft.com and AVAST at www.avast.com. Recently
Microsoft and Computer Associates (CA), announced that
for a limited time the $50 CA antivirus and firewall suite can
be downloaded for-free (for personal use) from www.myetrust.com/microsoft and includes a year of daily updates.
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Society news: Coming up

Adobe bails; February program uncertain
Programs
Adobe bailed out of the February
meeting, so at press time, the presenter
is not known.
The meeting will be Saturday, Feb.
28, at the Camarillo Boys & Girls Club
(see map on page 20). Doors open at 8
a.m., and the program starts at 11 a.m.,
after the Beginners and Internet SIGs
and the business meeting/question-andanswer session.

Other coming programs
March 27: Marcy Gunn of Smart
Computing
April 24: Price Grabber
May 29: Garage Sale
June 26

SIGs
Special Interest Groups (SIGs)
meet at Ventura County Computers in
Ventura. From the 101 Freeway, exit at
Telephone, take Telephone south to
McGrath, turn left and go one block.
Turn right on Goodyear and then right
again into the second driveway. Unit
117 is the back, right corner of the
industrial building. SIGs are sponsored
by CIPCUG and led by volunteers.
Unless otherwise noted, SIGs run from
6:30 to 8:30 p.m.
As Andy Toth, SIG coordinator,
notes, these SIGS are for the members’
benefit. The moderators are capable of
doing presentations week after week,
but that is not the purpose. There are
three ongoing SIGs and one free week
each month. The ongoing are Digital
Imaging, W3C, and Linux. Yes, Linux.
Recently, several members of the

Channel Islands Linux Users Group
joined CIPCUG. This is an enhancement to CIPCUG. Please let Andy
(pastpresident@cipcug.org) or the
moderator know what you would like.
This is a tremendous help.
If these SIGs are not benefiting
you, are at a bad time and place, or you
just want to gripe — let Andy know.
Silence is the most deafening sound
one can hear.
Here are the dates and proposed
SIGs for March and April:
Monday, March 1: Digital Imaging, Michael Shalkey: Take an image
you have been having problems with
and let the group work on the issue.
Please put the image on a CD. The
CIPCUG machine can accept .jpg and
PaintShop formats
Wednesday, March 10: W3C,
Toby Scott: Continuing the discussion
on making your website W3C compliant.
Thursday, March 18: Open
Q&A , Andy Toth: Bring your questions.
Thursday, March 25: Linux,
moderator and topic TBD at this time.
Monday, April 5: Digital Imaging, moderator and topic TBD at this
time.
Wednesday, April 14: W3C,
Toby Scott.
Thursday, April 22: Writing Your
Own Software, Andy Toth: VisuaBasic
makes it possible for the novice to
write applications for personal use.
You can make your software do what
you want with a minimal investment.
See a demonstration of how straight
forward it is.

February door prizes
The club door prizes for February
are:
Symantec Norton Anti-Virus
2004
W-X1W X-Mid Tower, Green
Light dot, Windows/LED 4 color
fan, 400w
Microsoft Wireless Optical
Mouse
We have two types of raffle
tickets: one for any prizes offered by
the presenter and one for clubprovided prizes.
The tickets for the presenter’s
prizes are free and limited to one per
member.
The tickets for the club-provided
prizes are $1 each, $5 for six tickets,
$10 for 13 tickets and $20 for 26
tickets and are available to anyone.
SIG reminders
available by e-mail
To keep members up to date on
coming SIGs, Andy Toth has agreed
to offer an e-mail reminder service to
club members.
Sign up and he will automatically
send you a reminder about two days
before each SIG, indicating the topic,
location, and date.
To sign up, send an e-mail to
siglist@cipcug.org with the subject
line “subscribe.”

Thursday, April 29: Linux, moderator and topic TBD at this time.

Worried about your computer security?
Among the Web sites that will check your exposure to hackers is Gibson Research Corp.
(www.grc.com), where you can run ShieldsUp! This will tell you what ports on your computer
can be seen by other computers on the Internet.
While you’re there, check UnPlugn’Pray, XPdite and Shoot the Messenger, all free programs to
help you plug Windows security holes.
Most antivirus programs’ Web sites also offer some free online checks of your computer.
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Society news: Business meeting, Q&A

KNX, KFI change weekend computer hosts
Reported by Martha
Churchyard
Secretary@cipcug.org

Business meeting
David Harris opened the meeting
with a reminder that next month’s
meeting will be Saturday, Feb. 28, the
first meeting on the new schedule.
John Weigle gave the Treasurer’s
report for Art Lewis. Income for December was $106.
David reminded us that this would
not cover the monthly rent of $160. It
is important to support the club’s fundraising efforts such as recycling ink
cartridges and the raffle.
In regard to the ink cartridges,
George Lakes announced that the recycler is now accepting only cartridges
with the printhead (the little copper
plates). Also please remember to put
the old cartridge in a box, such as the
one that comes with the new cartridge.
Reports were given for membership, TOE, and programs.
John Weigle thanked the dedicated
members of the folding group who
came out Christmas week to fold the
TOE.
Carla Kincaid is not able to do the
TOE mailing labels any more. If anyone is interested in doing this, please
contact a board member.

Q&A Session
Jeff Levy moves to KNX
Q: I have a comment for those who
listen to Jeff Levy on KFI. He has
moved to KNX 1070, 12 to 3 on Satuday and Sunday, reasons unknown.
KFI is having Leo La Porte now, also
form 12 to 3 Saturday and Sunday.
A: Leo La Porte is from Tech TV,
and he is really good, and quite funny.
Recyle bin disappeared
Q: My question is on the recycle
bin. It has disappeared from my desktop for some reason. How do I get it
back?
A: This site has several small fixes
for various ailments. Click on
“Restores a missing Recycle Bin icon
to the Windows XP Desktop” at
http://www2.whidbey.net/djdenham/
Tweekz.htm
(From audience) It could be that
the icon was accidentally shoved off
the screen, and he can get it back by
realigning the icons using “autoarrange.” Or he changed his screen
resolution.
I can’t open Internet Explorer
Q: I was starting a new Yahoo Email address and went through the
whole process, picked out a new URL
and so on, and now I can’t get a
browser.
I can open Outlook Express, but I

can’t open Internet Explorer.
A: There’s no connection between
signing up to Yahoo, and not getting a
browser.
What happens when you click on
Internet Explorer?
Q: I get a window that says “My
Yahoo,” and everything freezes and I
have to reboot.
A: When you suddenly can’t get on
the Internet or your browser doesn’t
work correctly, the first thing to be
suspicious of is spyware. But without
Internet access, it is going to be difficult. You might try running the one
that we distributed on the CIPCUG
CD, although it is almost a year old
now.
Laptop has modem problems
Q: I have a laptop with Windows
XP Home, and starting about a month
ago, when I close the lid or don’t use it
for a while, it started freezing up instead of going into hibernation. I get a
message that says, “Device driver for
the Toshiba software modem device is
preventing the machine from entering
hibernation. Please close all applications,” etc.
I’ve tried deleting that modem, and
it keeps coming back whenever I do it,
and nothing else I’ve tried seems to
work.
(Continued on page 5)

January Steering Committee meeting notes
By Martha Churchyard, secretary
The CIPCUG Steering Committee
Meeting was held on Jan. 6, 2004, at 7
p.m. at the home of George and Arline
Lakes.
Present: Martha Churchyard, David
Harris, Craig Ladd, George and Arline
Lakes, Art Lewis, Andy Toth and
Helen Long.
Art Lewis gave the Treasurer’s
report. Looking at all of 2003, expenses exceeded income by $700, very
reasonable since it includes big expen-
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ditures for the projection screen and
wireless equipment at the Camarillo
Boys & Girls Club. Craig Ladd reported on coming programs. He will be
attending the regional users group
meeting soon and hopes to finalize
arrangements for the coordinated vendor presentations. Andy reported on
SIGs. Ken was not present but submitted a written report on membership.
Helen Long reported that several members had taken advantage of the dis-
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count to pay ISP fees one year in advance.
The TOE used to carry ‘Personal’
notices. There was discussion of reviving this idea, either in the TOE or on
the Web.
There was also some discussion of
the idea of holding the board meeting
Saturday afternoon right after the general meeting. David will not be present,
but urged the board to give it a try in
February.
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Program:

Tips for individual users of Outlook, Word
By John Weigle
jweigle@vcnet.com
New and improved features of Microsoft Outlook and Microsoft Word
were described by Toby Scott at the
January meeting. Office 2003 will run
only on Windows 2000, XP and 2003
(that’s the server version). Most of the
new features and publicity relate to
large corporate settings. This program
highlighted new features or enhancements of interest to the individual user.
Of all the programs in the Office
2003 package, Outlook seems to have
had the most changes, so most of the
program was devoted to it, starting
with setting up an account.
To do that, open Outlook, and click
on Tools, E-mail accounts, which
opens the accounts wizard. It will walk
you through the process of setting up a
new account, or changing an existing
account and adding a new directory or
address book or editing an existing
address book. If you’re opening a new

account, you have to pick the type:
Microsoft Exchange Server (connect to
an Exchange server for your e-mail),
POP3 (connect to a POP3 server to
download mail), IMAP (connect to an
IMAP server for mail), HTTP (connect
to an HTTP server, such as Hotmail),
or Additional Server Types. You’ll be
asked for a variety of information that
you should have received from your
Internet service provider (server identifications and so on). After you complete the form, you can press a button
to check that your account is working
properly by sending a test message
using the settings you listed.
Outlook is a combination e-mail
program and personal information
manager, and the functions are well
integrated. For instance, Toby noted,
the out-of-the-box installation includes
a “For Follow Up” folder. You can
right click any message and mark it to
follow up (with the choice of six colored flags). The message shows up in
the For Follow Up folder as a re-

minder. The right-click menu also lets
you place mail in categories, such as
Business, Gifts, and Holiday Cards;
find related messages or other messages from the same sender; create
rules for mail from that sender or with
the same subject; or to list the message
as junk mail.
The junk mail list works both ways:
You can add a sender or domain to the
junk mail list or a safe list. This lets
you train Outlook to properly sort your
mail. Toby and others suggest that you
check the Junk E-mail folder periodically before deleting the contents. Although Outlook’s filters work fairly
well out of the box, they aren’t perfect,
and you might delete e-letters you want
or mail from friends or co-workers
who aren’t in your address book.
(Fred Langa has been having an
extensive discussion of this subject in
his e-mail newsletter because he conducted a test with volunteer subscribers
(Continued on page 6)

More on Q&A: Changing device drivers
(Continued from page 4)

A: Whenever you have an improper
device driver and it prevents your computer from going into hibernation mode
or shutting down gracefully, you can’t
just delete the hardware driver and
reboot, because as soon as you do, it
says, “New Hardware detected,” and
sets it up again with the same driver.
The only two choices are to remove
the device, which would be difficult
with a laptop’s built-in modem, or go
to the Toshiba Web site and get the
latest version of the device driver. You
will need the model number off the
bottom of the laptop.
Adelphia has to remove a filter but
can’t get there soon; can I do it?
Q: This has to do with Adelphia
versus Verizon. We just moved back to
Camarillo and are trying to get a highFebruary 2004

speed connection from whoever can
get to our house first. I have everything
approved with Adelphia, but they have
to come out and remove a filter and
can’t get there until next Tuesday.
Does anyone here know how to do
that?
A: They have to install the bypass
on your cable and run it to your computer (or network router). You can’t do
this yourself.
How do I change the folder that
Windows Explorer opens first?
Q: When I want to open Windows
Explorer, all it does is bring up the
“My Documents” folder. What can I do
to bring up something else?
A: How are you getting to Windows Explorer?
Q: I go to Programs, Accessories.
A: (Demonstrating) Go to the propThe Outer Edge

erties of that shortcut and look at the
target path. Probably it is being redirected.
Look at that, and if it has anything
after Explorer.exe, just remove that and
it should go to the system root.
Actually you can set up icons that
open up Windows Explorer in any location. Copy an existing shortcut to
Windows Explorer, right mouse click
on it and select Properties. In the Target box, after explorer.exe add a space
and then:
/e,c:\mydirectory
where “mydirectory” is the folder you
want Explorer to open up in.
Save it wherever you want it and
when you click on it, you’ll be looking
at what you want rather than what
Windows defaults to.
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More on program: Outlook has many changes
(Continued from page 5)

to the Langalist. “All filters make mistakes, but Bayesian filters and sophisticated rule-based systems are far, far
better than blacklists,” he declared in
the Jan. 19 issue. He described the results of the test this way in his Jan. 12
issue:
(“The basic test concept was simple: I sent one plain text, attachmentfree e-mail to each volunteer. The content of the e-mail simulated normal,
safe business or interpersonal correspondence. It contained no deliberate
or obvious spam- or virus-filter triggers
(e.g. no spamlike components, such as
offers to enlarge this or shrink that; no
attachments; no viruses; no HTML; no
embedded scripts; etc.). The subject
line was plain and general, neither designed to trigger nor avoid spam filters.
(“Plus: the recipients were expecting the mail: They knew it was coming,
although they didn't know the specifics
of where, when or how it would be
sent.
(“Even so, the results were dismal.
Some 40 percent of the test e-mails
didn't make it through!
(“Think about that for a minute:
This suggests that as many as four out
of 10 of your serious e-mails — the
sort you might exchange with coworkers, family, friends, business associates, or customers — may not be
making it to their intended destinations.
(“Or: Four out of 10 e-mails that
others send to you may end up lost
before you ever see them, *even if you
expect the emails and are looking for
them!*”)
(Details of the tests are posted at
http://www.informationweek.com/
story/showArticle.jhtml?
articleID=17300016.
(Don’t forget that many ISPs are
blocking what they consider spam before your e-mail program sees it. This
can work if users can check the mail on
the Internet to be sure the filters are
sorting properly. But if they can’t,
they’ll never know what’s blocked. My
ISP [VCNET, now part of IS West],
for instance, considered e-mail from
David Harris as spam, along with sev-
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eral e-letters. Both providers have ways
to fix the problem, but if they didn’t
provide web mail, I’d have never
known what was being blocked.)
As for spam, blocking an address in
Outlook might not do much good, because “spammers change their names
almost every time they send you email,” Toby said. He also explained the
reason that some e-mails have a string
of unrelated words at the top. They’re
an attempt to fool filters by having lots
of words that would pass the filters and
only a few words that might trigger a
block.
Outlook blocks the automatic
download of images that aren’t part of
the message, Toby said, because
downloading such images from the Net
confirms the validity of an e-mail address. If you want the images (or if
you’re getting them and don’t want
them), you can change the setting by
going to Tools > Options > Security.
Under Security Zones, click on Change
Automatic Download Settings.
Office updates include new spam
filters, he said, so it’s a good idea to
periodically visit the Office Online site
(http://office.microsoft.com/
officeupdate/default.aspx). Toby also
recommended checking Woody’s Office Watch at http://www.wopr.com for
tips and hints on Office products.
Tool bars have also been revamped,
Toby said. If there’s an arrow on the
right of a label (such as Search In),
click on it to see your choices. If you
haven’t used Outlook before, you
might not understand how to sort messages by anything other than date (the
default). Click on Arrange by: for the
choices. If you’re sorting by date, you
can have the oldest or newest messages
at the top.
If you don’t want all your mail to
go to the Inbox, you can set rules to
send it to a different folder — for instance all mail from CIPCUG officers
to a CIPCUG folder; all mail from your
boss or fellow workers to a Work
folder, and so on. Again, right click on
the message and use Create Rules.
If you drag e-mail to the calendar
button, you can make an appointment
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for yourself and open the e-mail from
the calendar to get additional information. Outlook also includes a Tasks list
and Contacts. The contacts list has
space for as much information as you
could possibly want about anyone:
Name, job title, company, business and
home phone numbers, fax number,
mobile phone number, addresses, email, Web page, IM message, and details on the person’s boss, assistant,
spouse and activities. “It got better in
XP, and it’s considerably better now,”
Toby said.
A Journal function, not installed by
default, is relatively complex, but it can
be used as a time contact manager and
as a way to track e-mail sent to or received from someone, appointments,
to-do list items. “The contact management system is pretty robust,” he said.
The Detect and Repair function
under the Tools menu works well on
quite a few things, Toby said. It appears on all the Office programs.
Moving on to Word, Toby noted
that the Auto Correct function fixes
spelling errors, but it can also be used
to add abbreviations to spell our
phrases (such as VCC = Ventura
County Computers). “Auto Correct
works across almost all of the Office
applications,” Toby said. To add items
to Auto Correct, go to Tools > Auto
Correct Options and type the changes
you want. Such abbreviations expand
when followed by a space so they can
be used as part of a word without problems. However, if you’re concerned
that you might get a change you don’t
want, consider using Auto Text instead
(Insert > Auto Text) so you have to
specifically ask for a change.
Toby had two recommendations if
Word or any other program crashes:
Do send an error report because Microsoft does look at the reports, and if
enough messages arrive it figures out
an answer and directs you to it (he was
told he needed a new video driver, for
instance). And use the recovery pane to
see what can be saved. You can set the
timing of automatic saves by going to
Tools > Options > Save tab.
(Continued on page 7)
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Review:

Microsoft Office 2003 offers new features
By Carl Bailey
1mrbig1@verizon.net
This is a review of installing and
using Microsoft Office 2003 Professional Edition, which was obtained as a
review copy. My operating system is
Windows XP with Service Pack 1, 384
MB of RAM and 40 GB hard drive.
When I started the installation, it
detected that I had a previous version
of MS Office 2000, and it asked me if I
wanted to keep or delete this version. I
chose to have it delete the old version.
For some reason it wanted to install the
new MS Office 2003 in the directory
C : \ P r o g r a m
Files\Microsoft\Frontpage2000. I
changed it to the C:\Program
Files\Microsoft Office directory where
my old version of MS Office 2000 was
installed. The program started the deleting and installing with no more
questions. The whole thing was fast
and no problems.
The first disk of MS Office Professional Edition 2003 installed MS Office 2003 Tools, Access 2003, Excel
2003, Outlook 2003, PowerPoint 2003,
Publisher 2003 and Word 2003. There
is a second disk that will install Business Contact Manger for MS Office
2003. However, before you can install
Business Contact Manger for MS Office 2003 you have to have installed
MS .Net Framework 1.1. This is a 23.1
MB download. For the time being I’m

going to hold off on installing this.
From what I can tell this is strictly for
Business use. It can help you manage
business contacts, track customer information and market your products
and service, allowing you to streamline
the way you do business. Since I’m an
old retired federal employee, I don’t
want to install and never use it again.
The first thing that you need to do
is buy a book that shows how to use
the various programs. No book comes
with the program. The help is also very
good to try to find out what you’re
trying to accomplish.
Access 2003: Access comes only
with the Professional Edition of MS
Office 2003.
So if you want Access you can’t
buy the cheaper editions like the Student & Teacher edition. I normally use
the database program Approach that
comes with Lotus SmartSuite. This
program looks similar to Approach. A
new feature that has been added is
“Back Up.” You can now back up the
current database before making any
major changes. The backup will be
saved in the default file location where
you save your normal files. You can
also enable automatic error checking
for common errors in forms and reports. This will point out errors in
printing and will help you identify and
correct them. This program is like all
new programs — you have to get in
and play with it in order to know how

to use it.
Excel 2003: As with the above
program I normally use Lotus 123 that
comes with Lotus SmartSuite. I’ve
used Excel some but not enough to be
an expert. This version looks the same
as the older 2000 version. A new feature that has been added is List functionality. In this you can create lists in
your file to associate and act upon a
group of related data. When you specify a range as a list, you can manage
and analyze the data independent of
other data outside of the list. You also
have the ability to publish a List on a
SharePoint team Web site. You can
now also work directly with the XML
elements within the worksheet.
Outlook 2003: This is the program that is the most different for me
personally.
I have used Outlook Express as my
mail program since I started going
online.
Outlook 2003 clearly received the
greatest overhaul I’ve been told. It configured and set up pretty easily. It lets
you import your address book from
other programs. It also imports all of
your rules to manage your various email accounts. I did this for OutLook
Express, and it added my entire address book under Contacts. When I
tried to create a new message I had a
lot of trouble using my address book. I
finally figured out how to make it look
(Continued on page 8)

More on using Outlook and Word ...
(Continued from page 6)

The Microsoft Application Recovery “does a pretty good job … in most
cases of recovering your document if
any of the Office applications lock up,”
he said.
The new Office Help function can
search online through the entire Microsoft KnowledgeBase (if your Internet
connection is on, of course) in addition
to the help files on your hard drive. It is
miles ahead of previous versions of
Help. If you have been less-thanFebruary 2004

impressed by Help before, don’t neglect it this time.
Toby also discussed customizing
toolbars; the reading layout, which can
create thumbnails of all the pages in a
document and readable-size pages in a
separate pane on the right, among the
other features.
You can create personal toolbars,
which can contain your company information, logo, signature, etc. as well as
macros you have created. They are far
more configurable than in the past and
The Outer Edge

one of the nicest new features.
The Reading Layout is similar to
Adobe Acrobat’s reader with thumbnails down the left and page layouts
either two -across or single-panel
(depending on screen width). In a long
document, it is quite easy to click on a
thumbnail and go directly to the page
you want to view.
With all the new features, Office
2003 is an excellent product, he said.
Whether it is worth the cost is a personal decision.
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More on Office 2003: New features described
(Continued from page 7)

at my address book from the To: or
CC: line of a new message. This took a
little bit of looking through the help
section. Although Outlook isn't the
perfect mail client and scheduler, this
version is substantially easier to use
and comes with a lot of new features. It
groups your messages from Today,
Yesterday, and Last Week and so on.
The ability to flag messages with a
single click (something Outlook Express already does) makes it easy to
mark important messages. And best of
all, you can customize Outlook’s
Search Folders to create new views.
Outlook finally incorporates antispam
measures, including a built-in filter and
the ability to build or even import lists
of accepted (whitelist) and junk mail
(blacklist) domains. Outlook not only
identifies mail as junk mail, but it also
automatically tosses that junk into a
new Junk E-mail folder or, if you want,
will automatically delete it. You can
now capture any block of text with
address and e-mail information as a
new contact by pressing Ctrl-C twice.
You’d better learn to like Outlook,
though, because Microsoft says it has
no current plans to support Outlook
Express beyond Version 6. Plenty of
users like me will be stumped by Outlook for a while. Like all programs it
takes time to learn to use it.
The Calendar part of Outlook is an
excellent feature that Outlook Express
didn’t have. I’m starting to use this
more and more. You can set up your
Appointments and the Reminder will
notify you at what ever time you tell it.
You can also print out the Calendar
that will show all your appointments.
Publisher 2003: Publisher 2003
offers an expanded selection of publi-

cation designs and publication types to
help you create professional-looking
publications. It has added 10 Master
Design Sets so you can select from a
total of 45 professionally designed
Master Design Sets when creating your
publications. Master Design Sets enable you to apply a consistent design
and identity to a range of common
publications. It also has enhanced layout and graphics features to give you
better control over how your design
will look.
Word 2003: Word now allows
you to save documents in XML format.
Word is more or less the same as its
predecessors. Word’s toolbars and task
panes, for example, look a bit flashier
and more colorful than in past versions, but that’s the biggest change. To
make digital documents easier to read,
Reading Mode (activated by the Start
Reading toolbar button) attempts to
reformat your documents to look like
printed pages — sort of like Adobe
Acrobat. But in Reading Mode, unlike
in Acrobat Reader or the former Print
Preview, your documents remain editable. Word now includes a formatlocking feature so you can lock down
any document’s formatting and style or
restrict the number of formatting styles
others can apply — creating, in essence, a template. This should appeal
to companies that want all official
documents to have the same look and
feel.
PowerPoint and Access now offer
up SmartTags, too, those sometimesannoying (but usually handy) icons
that automatically appear to mark such
things as addresses, names, and other
selected data, as Excel and Word have
done in the past.
PowerPoint 2003: With Power-

Point 2003 the viewer is improved, and
you can now package the slides for CD
using the Package for CD to distribute
the slides.
Package for CD allows you to
package your presentations and all of
the supporting files, including linked
files, and automatically run your presentations from the CD. PowerPoint
2003 support additional media formats,
including ASX, WMX, M3U, WVX,
WAX, and WMA. You can now write
directly into the PowerPoint slides on
tablet pc. This makes creating slides so
much simpler than before.
Conclusion: It is not possible to
list every possible application in the
Office 2003 suite. What I have done is
to point out the new features of common applications that I use.
I use Outlook 2003 every day and I
noticed that the speed improvements
compared to Outlook Express. Microsoft has pumped lots of new features
into the applications of the Office
suite. This is definitely one up from the
earlier versions.
I especially like the idea of the
spam filter, which is incorporated
within Outlook 2003.
This has been heavily used on my
Hotmail account, and I have a nice and
compact inbox with no more — well,
less — spam. This is really nice.
If you are an Office 2002 user and
if you use a tablet pc, this upgrade is
well worth the upgrade.
The only thing that seems to have
been left out is a PocketPC edition of
the applications bundled within Office.
Well, that could be possible in future
editions.
Overall, it is a nice experience using the new Office Professional 2003
especially the new features.

Wanted: Advertising Manager
We need someone to talk to computer-related businesses about advertising in The Outer Edge.
The editor’s job doesn’t allow him to sell advertising for a competitor, even one as small as TOE.
Anyone interested should contact Dave Harris or John Weigle at any meeting.
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Obituary:

Longtime member Bob de Violini dies
Robert “Bob” de Violini, who
served CIPCUG as vice president, editor of The Outer Edge and in other
capacities, died suddenly on Jan. 15 of
an aneurysm. He was 74. There were
no funeral services. He was cremated,
and he had his last flight with his ashes
spread to the winds over the ocean
from an airplane.
Mr. de Violini’s wife, Lois, a CIPCUG life member, was responsible for
the rent-free use of the old officers’
club at the Camarillo Airport for several years. She provided computer service to the Pleasant Valley Recreation
and Park District, which operates the
recreational facilities at the airport.
Mr. de Violini’s last appearance at
a CIPCUG microphone was at the December meeting during the discussion
of moving meetings from the first Saturday of the month to the fourth Saturday of the month. He described the
reasons for a previous change in meeting time, which resulted from a change
in meeting place from the Camarillo
Community Center to the Freedom
Center. This time, the meeting date
was changed because the new date is
closer to meetings of other computer
groups in the area, and the board believes that will make it easier to attract
top-notch speakers.
Even when Mr. de Violini was not
an officer, he remained an active member, showing up at meetings, taking
part in discussions, selling at the annual garage sale and contributing articles and criticisms to The Outer Edge.
In fact, he sent two articles, both of
which are in this issue, a few weeks
before his death.
Both Bob and Lois were listed in
the F1, Your Help Key, column for
several years.
In addition to his interest in computers, Mr. de Violini was active in
philately (stamp collecting). He was an
active philatelic writer and edited The
Compulatelist, a magazine similar to
The Outer Edge, which concentrated
on the use of computers in stamp collecting, from January 1992 to April
2003.
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He was the literature chairman at
SESCAL, an annual stamp show sponsored in Los Angeles by the Federated
Philatelic Clubs of Southern California, for several years. He was also the
Web master for SESCAL and the federation, and won awards for the SESCAL Web site in international competition.
He received the federation’s Distinguished Service Award in 1984. Lois
received the award in 1994, and the
late Barbara Williams de Violini received it in 1978.
In 1984, he organized OLYMPHILEX, a stamp exhibition in conjunction with the Los Angeles Olympics that year.
He was also a stamp exhibitor, and
his exhibit of stamps and covers related
to Capt. James Cook and his voyages,
won several awards. He also prepared
a “purely for fun” exhibit called
Curves on Stamps. The curves were
those of nudes, primarily well-known
works of art, pictured on stamps.
He was also active in the American
Polar Philatelic Society.
He and Lois were regulars at the
weekly cat adoptions at the PetSmart
store in Oxnard because of their interests in the cat rescue society Cats Cradle Rescue.
Mr. de Violini was born May 11,
1929, in Los Angeles and had been a
Ventura County resident for 50 years
coming from Burbank.
He was a 1956 graduate of UCLA.
He retired in 1986 with 35 years of
federal service. He worked as a meteorologist-climatologist in support of
test operations at the Naval Missile
Test Center, Point Mugu. He served in
the U.S. Air Force’s Air Weather Service and flew weather observation reconnaissance missions over Korea. For
a time, he was a part-time teacher of
meteorology at Moorpark College.
His hobbies included philately,
writing, editing and computers. He was
a 34-year member of the American
Philatelic Society and a member many
other philatelic organization. He served
as president of several, including the
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APS Writers Unit, American Society
of Polar Philatelists, the Philatelic
Computing Study Group and the Federated Philatelic Clubs of Southern
California.
In addition to the Distinguished
Philatelic Service award, he received
the Arizona State Philatelic Hall of
Fame Phoenix Award in 1987. In 1997,
the America Philatelic Society presented him with its Luff Award for
service to the society. This service included 12 years as the society’s affiliates coordinator.
In 1988, he served as U.S. commissioner for OLYMPHILEX 88 in Seoul,
Korea. He also served as secretary for
PACIFIC 97, the world philatelic exhibition held in San Francisco, where he
oversaw the first international display
of philatelic computer software. He
was an accredited philatelic literature
judge.
Robert was preceded in death by
his mother, Frances Treutler of Burbank; and father, Roberto de Violini.
He is survived by his wife, Lois
Evans-de Violini; sister, Lisa Curry of
Toluca Lake; stepsons, Mark, Peter
and David Evans; stepdaughter, Nancy
W i l l i a m s Q u a s t ; t h r e e s t e pgranddaughters; two step-grandsons;
and seven step-great-grandchildren.
A memorial gathering was held
Saturday, Jan. 31, and four CIPCUG
members attended.
Memorial donations, in Robert’s
name, may be made to the American
Philatelic Research Library, P.O. Box
8000, State College, PA 16803; The
Postal History Foundation, 920 N. First
Ave., Tucson, AZ 85719; Cats Cradle
Rescue, P.O. Box 5774, Oxnard, CA
93030; or the Spay and Neuter Clinic
of Ventura County, 2252 Craig Drive,
Oxnard, CA 93030.
Mr. de Violini’s arrangements were
entrusted to the care of James A.
Reardon Mortuary, 511 North A St.,
Oxnard.
CIPCUG extends its sympathies to
Lois. We will miss Bob and his many
contributions to the society and its activities.
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Society news: Web page

Some CIPCUG pages get security codes
We have new security codes for the
two password protected pages. The
current issue of the newsletter, and the
User Group Discount pages now appear as a link. When you click on the
link, it brings up the ENTER NETWORK PASSWORD box and requests
a User Name and Password. The password has not changed,
but we have added a
User Name and this was
mentioned at the last
meeting. If you were not
present, send me and email <liz@cipcug.org>,
LONG
and I will provide it for
you. Be sure to include
your membership number in the message. Once you have filled this form
out, you will never have to fill it out
again; the computer will remember it.
This action was taken because we
have had problems with Java Script
and W3 validation. Toby has set it up
removing the Java Script, and we didn't
have a problem with validation, except
that now, W3 cannot validate a password-protected page. So we are W3 HTML-Strict compliant except for the
two password-protected pages.

Several of our ISP members are
taking advantage of the club’s offer of
12 months of service for the price of 11
months when paid in advance. So, as
the year progresses, don’t forget this
offer when your ISP dues are due. I
will try to remember to remind you as I
send the invoices out, but in case I forget, you can remind me.
I will be starting new pages for the
Club Meeting Photos and the Behind
the Scene Photos for 2004. I may start
naming them Club Photos 2004 and

BTS 2004. Can you all remember that
BTS is the Behind the Scene Photos?
I try to keep all the titles to one
line, but it is a little difficult. Maybe I
will do away with the BTS separate
page and just combine them into one
file, and limit it to six months of photos instead of a whole year. What do
you think?
I might wait to do this and see if I
get any response. In other words, does
anybody read my column? I will be
very disappointed if I don't hear from
somebody.
Andy has made a couple of updates
on the User Group Discount page, so
be sure to have a look at it. He has
changed the format to make it easier to
move around on the page.
Be sure to check out the SIG INFO
page for the February classes. We need
to support the club’s effort. Andy
works very hard to put these together,
and the moderators give up their time
to share their knowledge. So be sure to
check out the schedule.
If we don’t cover the topic you
need help with, be sure to contact
Andy at <allonom@verizon.net> and
tell him what you need.

Watch out for that spoof e-mail message
(This article arrived just a few days
before Bob’s death. — Editor)

By Bob de Violini

Don’t trust every e-mail you receive from sources purporting to be
eBay, PayPal, Yahoo or other online
operations. Most of them are phoney
— attempts to get you to provide the
senders with credit card information
and passwords. They are known as
spoofs; they claim to be what they are
not. An excellent example is what was
in my e-mail today. It read:
From:
SeviceID_0823746@ebay.com
To: dviolini@adelphia.net
Subject: Billing Error ID: dviolini
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Date: 15 Jan 2004 023103 -0800
Dear eBay customer,
eBay recently tried to bill your account, but seemed to receive an
error when charging your card. This
can occur for a variety of reasons
including card expiration, over-limit,
suspicion of fraud, or several other
technical difficulties. Please visit
the secure eBay Service Center, by
clicking the below hyperlink, and
update your information so that this
issue can be resolved as soon as
possible.
eBay Service Center
Thank you,
Rick Johnson
eBay Billing Department

I did not. Last August I received
this one:
From: "service@ebay.com"
<service@ebay.com>
Subject: eBay Account -- ERROR
Date: Sat, 16 Aug 2003 104909
+0430
Dear eBay User,
During our regular update and verification of the accounts, we could
not verify your current information.
Either your information has
changed or it is incomplete. Please
update and verify your information
by signing in your account.
If your account information is not
(Continued on page 15)
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Society news: Beginners SIG

Microsoft extends Windows 98 support
(Notes for Michael Shalkey’s SIGS
are available on the Web. Go to http://
www.cipcug.org, click on Education in
the menu and then on Shalkey’s SIGs.
— Editor)
Michael’s program, setting up your
new computer, was originally supposed to be the December topic, but it
was delayed because we couldn’t get
the Internet connection to work. Some
of the information was included in the
January issue, using Michael’s online
notes.
After the SIG, at which Michael
said that Microsoft support for Windows 98 was about to end, Microsoft
released a new time schedule. Here are
the details from http://
support.microsoft.com/default.aspx?
scid=fh;[LN];LifeAn1:
“Paid incident support for Windows 98, Windows 98 Second Edition,
and Windows Millennium Edition
(Me) is available through June 30,
2006.
“Customers can request security
fixes for Windows 98, Windows 98
Second Edition, Windows Me, and the
most current version of their compo-

nents until June 30, 2006
through normal assistedsupport channels.
“Windows 98, Windows 98 Second Edition,
and Windows Me
downloads for existing
security issues will conSHALKEY
tinue to be available
through regular assistedsupport channels at no charge until
June 30, 2006.
“No-charge incident support and
extended hotfix support for Windows
98 and Windows 98 Second Edition
ended on June 30, 2003.
“No-charge incident support and
extended hotfix support for Windows
Me ended on December 31, 2003.
“Online self-help support will be
available until at least June 30, 2007.”
That’s good news for those who
don’t want upgrade their Windows yet,
although the time will come when it
will be necessary as hardware and software keep changing.
Assuming your new computer is a
replacement, you probably have things
on the old one that you want to move.
Short of taking out the old hard drive

and putting it in the new machine, that
means you have to figure out what to
keep and how to get it to the new computer.
The My Documents folder and all
its subfolders are obvious choices. But
don’t forget things like your Favorites
or Bookmarks for you Web browser,
your e-mail and address book and other
data that is stored in program folders
rather than in My Documents. Also, be
sure to copy downloads, both programs
and data files.
It’s almost impossible to transfer
programs from one disk to another
because today’s programs drop files in
many directories and make changes in
the registry. You’ll need the original
installation disks for that. Find them —
and the registration numbers if applicable.
After installing the OS and programs, install and update an anti-virus
program. “As long as you have one, I
don’t care what it is because it’s better
than nothing,” he said.
Set up your printer and other peripherals and set up your Internet connection (more information to be sure
you have somewhere).

Many programs available for reviews
Many companies want us to review
their software. If you’re interested in
any of the following programs, send an
e-mail to editor John Weigle
(jweigle@vcnet.com) for all the details.
The only requirement is that you
write the review for The Outer Edge.
You can, of course, keep the software
after writing the review.
The format of the listing is company name, software name, brief description, Web site and price, all taken
from the companies’ requests.
Green Parrots Software: 1st TurboRun 2.0, an instant file launching
pad for Windows 95/98/ME/NT/2000/
XP/2003. Why keep clicking and
browsing through numerous folders if
February 2004

you can type several letters of the desired application or document file
name and then press Enter to launch it?
And, instead of looking through bookmarks, the program can be used to find
any URL link with a few keystrokes.
1st TurboRun does not require long
reindexing and folder refreshing every
time the program is started, and it offers two -click access to recently installed or used files and documents. 1st
TurboRun is distributed electronically
over the Internet; free demo version is
available at http://www.turborun.com
for evaluation. The price of a single
copy is $24.95.
PhotoActions: AlbumWeb Pro
2.40, a Web album creation software
for Windows 95/98/ME/NT/2000/
XP/2003. Create Web-based albums,
The Outer Edge

slide shows and CD presentations. AlbumWeb Pro is distributed electronically over the Internet; free demo version is available at http://
www.photoactions.com/awebpro/ for
evaluation. The price of a single copy
is $39.95 for the home license. Business license is available at $59.95
Bolide Software: All My Movies
2.0, a movie database program that
stores information about your movies
for Windows 95/98/ME/NT/2000/
XP/2003. All My Movies 2.0 stores
title (both original and adopted for
foreign movies), director, year of release, actors, genre, description, type
of storage media (VHS, DVD, AVI
file, etc.) and so on. All My Movies 2.0
is distributed electronically over the
(Continued on page 12)
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More on programs available for review ...
(Continued from page 11)

Internet; free demo version is available
at http://www.bolidesoft.com/ for
evaluation. The price of a single copy
is $24.95.
ArcticLine Software: Bee Icons
3.0.8, icon management application.
Bee Icons offers an easy way to change
icons together with over 250 icons and
30 themes for Windows 95, 98, ME,
2000, and XP shells to choose from.
All icons and themes are free to
download. Bee Icons is distributed
electronically over the Internet; free
demo version is available at http://
www.beeicons.com for evaluation. The
price of a single copy is $19.95.
Sidency Softworks: Collmate, a
collector’s assistance software program
for Windows 95/98/ME/NT/2000/
XP/2003. Collmate, which stands for
Collector’s Mate, is a database software application capable of tracking
collection items, displaying pictures,
descriptions and value of collectibles.
More importantly, this information can
be exported to HTML or CSV formats
for sharing with other collectors
(online and offline) or for insurance
purpose. Collmate 1.20 is distributed
electronically over the Internet; free
demo version is available at http://
www.sidency.com/ for evaluation. The
price of a single copy is $24.95.
AKS-Labs: Compare Suite 1.0, a
Windows 98/95/XP/2000/ME/NT file
and folder comparison tool with merge
and reporting abilities. Compare Suite
allows users to compare files and highlight found differences, which include
new, modified or deleted words. Those
who deal with office documents can
compare MS Word (.doc) and MS Excel (.xls) files, Adobe Acrobat (.pdf)
documents as well as Web page (.htm).
Personal version of Compare Suite
costs $60. For more information, visit
http://comparesuite.com/press.htm.
Code Sector Inc.: Cute Organizer
1.7, a personal information manager
for Windows 95/98/ME/NT/2000/
XP/2003. Cute Organizer 1.7 goes
beyond simply storing contact information. The software is capable of
scheduling tasks and appointments,
tracking assignment progress, alerting
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users of approaching deadlines or important dates and doing other chores
for you. In addition, Cute Organizer’s
address book is fully compatible with
that of Outlook and Outlook Express.
Cute Organizer 1.7 is distributed electronically over the Internet; free trial
version is available at http://
www.codesector.com/ for evaluation.
The price of a single copy is $25.
Scorpio Software: Golden Warlock
Studio: Gunner II, a computer game
for Windows 95/98/ME/NT/2000/
XP/2003. This is a new version of the
3D anti-aircraft shooter. The game
features six types of weapons, 19 enemy crafts, great graphics, studio quality sound effects, addictive gameplay,
and adrenaline rush action. For more
information, go the company Web site,
http://www.warlockstudio.com/
gunner2.html.
FSPro Lab: Identity Knight, a
privacy protection software for Windows 95/98/ME/NT/2000/XP/2003.
Identity Knight provides a surprisingly
simple and effective solution that lets
people continue using AutoComplete
form filling, while eliminating any risk
for private data to be stolen. Simply
enter information that needs to be deleted from Windows Protected Storage
(where AutoComplete data is stored)
— credit card and Social Security
number, residence address, e-mails,
names and so on. Now, even if computer gets lost, stolen or hacked, it will
not contain any information that will
be of any value to criminals. Identity
Knight and Credit Card Knight are
distributed electronically over the
Internet; free demo versions are available at http://www.fspro.net/ for
evaluation. The price of a single copy
is $34.95 and $24.95 for Credit Card
Knight.
Helicon Tech: ISAPI_Rewrite 2.2 ,
an MS Internet Information Server
add-on for Windows NT/2000/
XP/2003. ISAPI_Rewrite is a URL
manipulation engine created specially
for Microsoft’s Internet Information
Server (IIS). The tool is similar to
Apache’s mod_Rewrite and is equally
easy to use. ISAPI_Rewrite 2.2 is distributed electronically over the InterThe Outer Edge

net; free trial version is available at
http://www.isapirewrite.com/ for
evaluation. A single copy is $69. A
freeware version of the program, called
ISAPI_Rewrite Lite, is available at the
manufacturer’s Web site.
OkoSoft: LockTheFile 1.8 , a fileprotection routine for Windows 98.
The program makes sure no wrong
person ever gets access to the protected
files. It does it by using strong encryption algorithms and requiring a password to unlock the protected file.
LockTheFile 1.8 is distributed electronically over the Internet; free demo
version is available at http://
www.okosoft.com/ for evaluation. The
price of a single copy is $28.95.
fCoder Group Inc.: PhotoMix Collage 5.0, a collage creating software
for Windows 95/98/ME/NT/2000/
XP/2003. The new version features
improved interface, built-in basic image editor, advanced printer manager,
and convenient picture layout processor, works faster and has lower system
requirements. PhotoMix Collage is
distributed electronically over the
Internet; free demo version is available
at http://photomix.fcoder.com/ for
evaluation. A single copy is $29.95.
SmartLine Inc.: PortsLock 1.4 for
Windows 95/98/ME/NT/2000/
XP/2003. PortsLock lets system administrators restrict access to the TCP/
IP connections. PortsLock costs $50
for a single-user license. A free, fully
functional demo is available for
download from http://
www.portslock.com.
LastBit Software: RegSnap 4.0, a
Windows registry analysis and batch
registry file processing tool for Windows 95/98/ME/NT/2000/XP/2003.
RegSnap 4.0 tracks changes done to
the Windows registry files and also
analyzes alterations done in other parts
of Windows OS, like modifications in
a list of files in Windows and Windows System directories, Program
Files and My Documents, win.ini and
system.ini files, autoexec.bat and config.sys files. In addition to providing a
detailed HTML report, the program
enables users to undo (or redo) any
(Continued on page 13)
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changes done to the registry files.
RegSnap 4.0 is distributed electronically over the Internet; the freeware
version of the program is available at
http://www.lastbit.com/regsnap/ for
download. RegSnap 4.0 costs $29.
RegSnap Pro 4.0 costs $45. A site license is available for $275.
ShellPlus Development Group:
ShellPlus 2.3, a set of Delphi/C++
Builder programming libraries that
enable Delphi and C++ Builder developers to write feature-rich applications
with help of shell/namespace extensions. For more information, contact
ShellPlus Development Group at
http://www.shellplus.com/.
Acoll Software: Smart Converter
1.7, an image conversion software for
Windows 95/98/ME/NT/2000/
XP/2003. Smart Converter supports
more than 80 image formats, ranging
from common JPEG, BMP and GIF to
industry-specific G3F, TPIC, or IRIS.
In addition, the program is crammed
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with features, tools, filters and special
effects for image processing. Most
importantly, all operations can be carried out in a batch mode. Smart Converter 1.7 is distributed electronically
over the Internet; free demo version is
available
at
http://
www.smartconverter.com/ for evaluation. The price of a single copy is
$44.95; the Command Line edition is
priced at $74.95.
Aha-Soft: ArtIcons 4.0b, an icon
processing tool for Windows 95/98/
ME/NT/2000/XP/2003. ArtIcons is a
tool for working with icons that enables you to create, edit, extract, export
and import icons and process icon libraries. ArtIcons is distributed electronically over the Internet; free demo
version is available at http://www.ahasoft.com/ for evaluation. The program
supports all popular image formats,
including but not limited to ICO, BMP,
JPEG, ANI, CUR, WMF, GIF and
PNG files. The price of a single copy is
$19.95 for ArtIcons Standard and
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$29.95 for ArtIcons Professional until
the official release of ArtIcons v4.0.
ExactTrend Software: A new line
of Web log products for Windows
95/98/ME/NT/2000/XP/2003 that includes three titles — Web Log Explorer, Web Log Suite and Web Log
DB.
These tools can thoroughly
“dissect” Web site traffic data to show
where most traffic comes from, which
key phrases generate more visitors,
what the target audience is, where the
strong and weak points in visitor-tobuyer conversion scheme are, as well
as to provide webmasters and site owners with helpful insights how to make a
site more visitor friendly and profitable. Web Log DB is $69.90. Web Log
Explorer and Web Log Suite are available in Standard and Professional versions priced at $49.90 and $89.90, and
$54.90 and $94.90, respectively. Refer
to the table at http://
www.exacttrend.com/compare.html for
more information about features each
version offers.
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Review: Executive Software Diskeeper

Diskeeper easy-to-use program to defrag drives
By Jim Thornton
jthorn@adelphia.net
One of the worst things that can happen to your computer is having a highly fragmented hard drive. Common
symptoms are slow responding programs, slow boot-up
times, slow shutdown response, system crashes, etc. The
solution is to regularly run a defragmentation program. But
first, how do hard drives get fragmented? When your computer moves files between your hard drive and RAM
(random access memory), often the space where the files
came from is no longer available. Therefore, your computer
breaks up the returning files to fit into smaller free spaces on
your hard drive, resulting in your files being fragmented or
scattered all over your hard drive and not sitting adjacent to
each other. Defragging programs reassemble the file pieces.
The most common programs are Microsoft’s Disk Defragmenter, Norton Utilities’ Speed Disk, and Executive Software’s Diskeeper. Let’s compare these programs and determine which is the best for you.
DISPLAYS — During the defragging process these programs graphically display what is going on. Speed Disk provides the most detailed information, identifying 21 different
blocks — blocks in use or filled with data, partial filled
blocks, unused or empty blocks, blocks being moved, damaged or bad blocks, swap file blocks, memory file blocks,
etc. Disk Defragmenter shows nine different blocks and
Diskeeper shows seven.
MOVING FILES — Both Disk Defragmenter and
Speed Disk will rearrange or optimize your programs for
faster loading. Diskeeper lacks this feature. Speed Disk goes
a step further and allows you to select the folders and files,
either by name or by date and time, to be moved into the
faster or slower loading areas. In addition, with Speed Disk
you can identify files not to be moved.
AREA TO DEFRAG — All programs will defrag the
entire drive. Speed Disk allows you to specify only certain
areas to be defragged — the folder and file area, the free or
unused area, or the swap file. By selecting only the folder
and file area the defragging time is shortened. Another feature of Speed Disk during defragging is that it can wipe the
free areas clean. This means the program writes ones and
zeros to the free space and then erases them, totally obscuring any data previously stored in that area.
REMAINING TIME — All programs fail to provide
how much time is left before the defragging process is completed. This is something that would be very useful; instead,
the programs show percentage complete. Speed Disk also
displays the time (in hours, minutes, and seconds) since the
current process began.
SAFE MODE — Disk Defragmenter and Diskeeper run
equally well in the regular and safe modes. By using the safe
mode, only the most basic hardware drivers are loaded, al-
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lowing the defragging programs to complete faster. Speed
Disk does not work in the safe mode.
FLOPPY DRIVES — Disk Defragmenter and Speed
Disk both defrag floppy drives while Diskeeper will not.
SPEED — Diskeeper is the fastest, taking only three
minutes to defrag an 18GB (18,000,000,000 byte) hard
drive half full of data. Speed Disk took three times longer,
and Disk Defragmenter four times. The slower defrag times
are due to both Disk Defragmenter and Speed Disk checking for errors, moving files into a faster loading area, etc.
Diskeeper relies on Microsoft’s Windows -based Scan Disk
program to check for errors and does not move files.
RUNNING IN THE BACKGROUND — Disk Defragmenter and Speed Disk work best when there are no
other programs running in the background. If there are, the
defragging programs will start over from the beginning
every time there is an ever so slight change to the hard
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More on Diskeeper review ...
(Continued from page 14)

drive. This is because these programs first must analyze the
entire hard drive to determine the best way to reassemble the
fragmented files back together again — a process similar to
solving a Rubik Cube puzzle. A typical interruption could be
your mail program checking for new mail every few minutes.
Diskeeper does not have this limitation; however, if you do
use your computer while Diskeeper is running in the background, you may observe a slowdown.
WHEN TO RUN — Disk Defragmenter and Speed Disk
are manual defraggers, i.e., it is up to you to determine when
to run the program. To determine if the drive needs to be defragged, you can see the last time that the drive was defragged
by Disk Defragmenter by left-clicking on My Computer,
right-clicking on the drive that you are interested in, leftclicking on Properties, and left-clicking on Tools tab. To see
when the last time that Speed Disk was used, left-click on My
Computer, right-click on the drive that you are interested in,
left-click on Properties, and left-click on the Norton tab.
Diskeeper does not update the My Computer information.
Some experts suggest that the main hard drive should be defragged monthly on heavily used computers and less frequently on others. These programs can be set to run on specified dates and times by using Windows’ Task Scheduler.
Diskeeper has its own internal scheduler (“Set It and Forget It”) that can be programmed to run every night, on weekends only, or whenever the screen saver is activated. In addition, it can be set to run whenever a certain level of file move-

ment has been reached.
REPORTS — Speed Disk and Diskeeper provide detailed reports ranging from number of fragments per file,
percent of fragmentation, etc. Disk Defragmenter lacks this
feature. Diskeeper also provides a graphic comparison of
the computer’s performance improvement before and after
defragging.
COST — Disk Defragmenter is free, as Microsoft has
included it since the first introduction of Windows 95. The
retail price for Symantec’s Norton SystemWorks 2004 program (which includes Speed Disk) is $70 and Executive
Software’s Diskeeper the Home Edition version 8.0 is $35.
RECOMMENDATIONS — The easiest defragging
program to use is Diskeeper <www.executive.com> as it is
the fastest, runs in the safe mode, runs in the background,
provides good reports, has its own scheduler, and Microsoft
provides a less feature rich version of Diskeeper with Windows 2000 and XP instead of its own Disk Defragmenter.
The program with the greatest user control is Speed Disk
<www.symantec.com> with a good display, optimization of
files, control of areas to be defragged, ability to defrag floppies, and it’s bundled with many other useful Norton Utilities, Anti-Virus, and CleanSweep programs. A satisfactory
program is Disk Defragmenter, which runs in the safe mode,
defrags floppies, and optimizes files, but the lacks the advanced features of Speed Disk and Diskeeper. All three
defragging programs are compatible with all versions of
Windows, 95, 98, Me, 2000 and XP.

More on spoof e-mail messages ...
(Continued from page 10)

updated within 5 days, your access to bid or buy on
eBay will be restricted.
Please go to the link below and enter the information
required:
http//www. [rest of URL deleted]
What clued me in to the fact that these were schemes to
get credit card information was that I have never bought
anything from eBay or ever registered with eBay as a buyer
or seller. Therefore, why would eBay be contacting me?
They do not know that I exist.
Other clues are the links I was supposed to click on. The
latest was the “eBay Service Center.” When I placed my
cursor on the link — but did not click — there was no URL
showing at the bottom of the screen as you would expect to
see. There was only an IP address, the set of numbers such
as 123.456.78.90 (not the real one for this place) that is the
address in the Internet system for a Web site that we use a
URL to contact.
What should you do with such messages? (1.) Do not
reply to them or do anything that they ask you to do. (2.)
Forward the message to spoof@ebay.com (if it claims to be
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from eBay), or spoof@paypal.com if it claims to be from
PayPal. (3.) Delete the message and then delete it from your
trash folder. Also delete any attachments that might have
been sent with the message.
Play it safe and do not trust any messages that ask for
information. If in doubt, contact the firm’s customer support
people for confirmation. Do not use any address or phone
number that might be given is such a message.
Stay alert and practice safe computing.
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Society news: Membership report

Is it time for you to send your dues?
By Ken Church
membership@cipcug.org

Welcome to the following new members: Tanner
Burke, Shawne Lardin, John Meler, Bill Wayson, and
Justin Wilson
Attendance at the Janurary 2004 General meeting:
89 Members
3 Guests
Total membership: 328
RENEWAL INFORMATION
The renewal/New Mbr dues are
$25/$35 for single membership,
$30/$50 for two or more family membership.
Please send your renewal payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the Feb. Meeting at the Boys
and Girls Club of Camarillo.

December 2003 renewals:
Mbr# Last Name First
Name
1045 Franco
Ernesto
0749 Landreth
Bill
0536 Larraburu
Philippe
1077 Levy
Miguel
0825 Pinkerton
Ron
January 2004 renewals:
Mbr# Last Name First
Name
0654 Cayou
Mylo
0088 Gandin
Dr.Morris
0647 Harte
Maureen
T
0754 Harvey
Harmond
0552 Hernandez Susan
0540 Jennings
Clay
1021 La Madrid Victor
0753 Otterson
Dick
1088 Scheer
Ted
0950 Skultety
Tony
0910 Smitley
Lee
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Pd to Date
200312
200312
200312
200312
200312

February 2004 renewals:
Pd to Date
Mbr# Last Name First
Name
0299 Boshoff
Henri
200402
0180 Daily
John
200402
1063 Fields
Dwayne
200402
0410 Fleig
Roland
200402
0412 Guess
John
200402
1116 Hazeltine
John
200402
0862 Horwald
Jacqueline
200402
0395 Horwald,
Sylvan H.
200402
MD
0843 Isaman
Harry
200402
0851 Malloy
Gene
200402
1084 Martinez
Sam
200402
0565 Meeker
Mary
200402
0656 Mori
Ken
200402
T
1047 Norton
Henry
200402
1082 Perry
Jim
200402
0306 Presutto
Joe
200402
1083 Stoutz
Hank
200402
1085 Temple
Gregory
200402
0098 Vlazny
Don
200402
1054 WasserHarold
200402
man
1086 Wiens
Jim
200402

Pd to Date
Internet connection at the new location.

200401
200401
200401
200401
200401
200401
200401
200401
200401
200401
200401

Looking forward to seeing all of you on Feb. 28, 2004,
for our general meeting at the Boys & Girls Club of Camarillo, 8:45a.m. to Noon.
Just to let the members who have not been able to make
it to the new meeting location know, we are now connected
to the Internet. So when Toby Scott gives us an answer to a
question, Michael Shalkey can show you how it looks on the
big screen.
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Virus)
PCAnywhere

F1—Your Help Key

DM

WORD PROCESSING
Microsoft Word
WordPerfect.

BW, DM
DM

WINDOWS
Windows 98, 95
Windows Me
Windows 2000
Windows NT

DM, JM, AT (98), MS (98)
JT, AT
TS, AT
TS

Initials
AT

Name
Andy Toth

(805)
604-7538 (e)

BR

Bill Robinson

BW

Bart Wood

389-2997 (b)
<billwr@adelphia.net>
482-4993 (e)

DM

David Minkin

469-6970 (cell) (5-11 p.m.
weekends);
dddave@QuixNet.net

JM
JT

Jerry McLoud
Jim Thornton

(818) 889-6176 (e)
987-1748 (d)
<jthorn@adelphia.net>

MS

Michael Shalkey

483-9921 ext 142 (d)
mshalkey@cipcug.org

RP

Robert Provart

TS

Toby Scott

TZ

Trish Zakas

(Revised Sept. 14, 2003)

COMMUNICATIONS/INTERNET (GENERAL)
Compuserve
DM
Note Tab Pro
TS
World Wide Web
DM, TS
DATABASES
Access

BR

DOS

RP

EDUCATIONAL / CHILDREN

TZ

E-MAIL
Eudora
Lotus:CCMail.
Outlook
Outlook Express
Poco Email

JT
DM
TS, AT, MS
TS, AT, BR
MS

GRAPHICS
IrfanView

289-3960 (d)
tech@cipcug.org
985-8519 (b)

JT

HARDWARE, UPGRADING

JM

HTML

TS, AT

NETWORKS

TS

OFFICE SUITES
MS Office
Open Office
Star Office

AT
AT
AT

GRAHICS PROGRAMS
IrfanView
Print Shop

MS
BR

SPREADSHEETS
Microsoft Excel
Quattro Pro

DM, AT
DM

UTILITY PROGRAMS
Norton Utilities

DM, JT (and Anti-
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498-8477 (b)

Phone: (d) = days; (e) = evenings; (b) = both
If you would like to volunteer to help others, please
send your contact information and programs you’re
willing to help on to <editor@cipcug.org>.

Practice safe computing:

Back up

Back up

Back up
(And then test the backup to be
sure it worked)
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Editor’s corner:

Farewell to a friend, more TOE changes
CIPCUG lost a longtime friend and supporter last
month. Bob de Violini, who had been our vice president/
program chairman, TOE editor and contributor, and probably the holder of jobs I’ve never even known
about, died unexpectedly while at a restaurant
with his wife, Lois. If you hadn’t already heard
the news, Bob’s obituary, a combination of
personal knowledge and the obituary published
in the Ventura County Star, is on page 9, and
Bob’s final article for TOE is on page 10. He
had also sent this short filler item from a source
he didn’t list:
WEIGLE
“I heard that if you play the Windows CD backward you can hear satanic speech.”
“Well, that’s nothing. When you play it forward, it installs Windows.”
I knew Bob as a stamp collector long before I was interested in computers. He was active in the Ventura County
Philatelic Society, as was his then-wife, Barbara Williams
de Violini, and the two of them got me interested in expanding my philatelic knowledge and starting to exhibit my collection. While I haven’t done nearly as much as Bob did in
the philatelic world, his encouragement, and that of Barbara
and later Lois, made me get more active in regional philately.
Bob didn’t suffer fools — or foolish actions — gladly.
He was free with assistance — and criticism when he
thought it was deserved, but whatever criticism he offered
was with the goal of improving whatever you were working
on.
He prepared the nameplate for TOE, although I could
never get it to reproduce in MS Publisher exactly the way he
prepared it in Word Perfect.
Bob might have belonged to some groups that he did
little or nothing for, but, if so, I have no idea what they
were. Everyone who spoke at his memorial service remembered him as being a workhorse in whatever group he
joined.
Like many others, I will miss him.
***
You might have noticed some changes in this issue —
again (if you didn’t, the headlines are flush left instead of
centered). I’m trying something I read in a design book by
Robin Williams (not the comic; this Robin is a woman who
has written several books on typography and the design of
both print and Web pages). Most of the headlines in the
Ventura County Star, where, most of you might know, I
work, are flush left, but I’ve always liked centered headlines
if they spread across the entire page, as most of those in
TOE do. We’ll see how it works.
I might also try the same thing with the bylines, but
I’m not sure if I’ll be able to do it in this issue.
TOE passed a milestone — the 200th issue — a couple
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of months ago that I neglected to point out at the time.
Unless the whole numbers have been messed up more than
once, we are now at issue No. 203. I don’t know who our
first editors were, but I know that Bob de Violini and Stan
Ransom took the publication through many of those issues
before I got the job. To them, to our writers, to our advertisers and to members of the folding committee and others
who have helped TOE stay on track, I thank you for both
the society and myself.
— John Weigle, Editor

Society news

Treasurer’s report
By Art Lewis
<treasurer@cipcug.org>

December 2003
Category Description

12-1 through
12-31, 2003

INCOME
ISP Income
New Members
Raffle
Renewals

540.00
105.00
18.00
470.00

TOTAL INCOME

1,133.00

EXPENSES
Coffee-Doughnuts
Equipment
ISP Expense
Storage
TOE

25.00
20.72
505.00
50.00
423.25

TOTAL EXPENSES

1,023.97

TOTAL INCOME – EXPENSES

109.03

Unrestricted Funds

7,255.74

Restricted Funds

2,000.00

Bank Balance 12/31/03

9,255.74

Year to Date Income

8,551.95

Year to Date Expense

-9,212.06
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Why join Channel Islands PC
Users Group (CIPCUG)?
Every month, members of the
Channel Islands PC Users Group have
access to:
♦ The Outer Edge newsletter,
which includes a list of
members willing to help other
members
♦ The general meeting, featuring
a question-and-answer session
and program on new software
or hardware
♦ Special Interest Groups —
special meetings held several
times a month on a variety of
topics
♦ Door prizes at the regular
meeting.
♦ The CIPCUG library of books
and videos.
Other benefits include:
♦ Special user group discounts
on books and software
♦ An Internet Service Provider
at a large discount (see
below).
♦ A chance to make friends with
people who have similar
interests
♦ The ability to put your
knowledge to good use by
helping other members. The
whole concept of user groups
is members helping members.

CIPCUG members are eligible to
sign up for the group’s Internet
Service Provider (ISP) at the low price
of only $15 per month plus a $15
processing fee.
To sign up, contact one of the
club’s techies (see below). Call one of
them you may know or one in your
area and they will be glad to provide
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you with the details necessary for
signing up. Checks should be made
payable to CIPCUG and forwarded to
Treasurer, c/o CIPCUG, P. O. Box
51354, Oxnard CA 93031. Don’t
forget to include the $15 set-up fee in
your first sign-up check. You may
make payments in three-month, sixmonth or annual increments. Renewals
can also be mailed to Treasurer; just
be sure to mention the dates that your
check is to cover.
There is no program to install; you
will use programs that are already on
your computer. It’s simple to talk you
through the set-up, but if you’re the
least bit timid about setting up your
computer, a club member will come to
your house and make the necessary
arrangements. Our agreement will also
give you a 5 MB Web page allowance.
_________________________
CIPCUG INTERNET SERVICE
TECH TEAM
Jerry Crocker, 486-0308, 6-10 p.m.
normsplumb@aol.com,
Roland Fleig, 983-8707, mornings
schwable@cipcug.org,
George & Arline Lakes, 983-2969, 210 p.m.
thelakes@cipcug.org,
Helen Long, 642-6521
liz@cipcug.org
David D. Minkin, 469-6970, 5-12
p.m., weekends
dddave@QuixNet.net
______________________________

CIPCUG MEMBERSHIP
APPLICATION
Amount enclosed:
____________________________
Please Print the following information:
Name:
_______________________________
Address:
_______________________________
City:
___________________________, CA
ZIP Code:
_______________________________
Phone no. (Home): _______________
(Work): _______________________
E-mail address:
_______________________________
User level: Novice _____;
Intermediate _____; Advanced _____
Can you help the club as a volunteer?
If so, what would you be interested in
working on?
Date ___________________
Member # ____________

Please clip last column and send
with payment to CIPCUGMembership, P.O. Box 51354,
Oxnard, CA 93031-1354.
Please make checks payable to
CIPCUG
Dues for new members
Individual member, $35.00
Family membership (same
address), $50.00
Renewals are $25 and $30/yr.
respectively
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DUES REMINDER
If the number after your
name is 0402, your
membership dues are
payable in February
2004.

FEBRUARY 2004 MEETING
OF CHANNEL ISLANDS PC USERS GROUP
Saturday morning, Feb. 28,
at
Boys & Girls Club,
Ponderosa Drive and Temple
Avenue, Camarillo, Calif.
Meeting Schedule:
0830
Doors open
0845-0930 Beginners’ SIG and Internet
SIG
0930-1030 Business meeting, Q&A
1030-1100 Break — Please contribute
requested amounts for
coffee and doughnuts
1100-1200 Program (TBA), Drawing
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Help your fellow members.
Volunteer to lead a SIG.
More details available from
Ralph Duchacek, Andy Toth,
Helen Long or Toby Scott at
any meeting.

Why join CIPCUG?
Here are just a few of the reasons:
Monthly SIGs, a monthly program, a
monthly newsletter, a discounted
Internet Service Provider, a library of

Benefits of CIPCUG
membership include:

If you’re looking for tips from other members,
check the CIPCUG Web page.
The Outer Edge, our
monthly 20-page newsletter
Free tickets for
presenters’ prizes at our
monthly meeting
A variety of Special
Interest Groups (SIGs) every
month
The society’s Internet
Service Provider for $15 per
month
February 2004
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